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Preface 

Thyroid hormones act on virtually any cell in the organism. They play a central role 
in metabolic coordination and differentiation. Robust control of thyroid 
homeostasis is therefore essential for survival, differentiation and reproduction [1]. 
 
In 1940, eleven years after the discovery of the thyrotropic hormone TSH by Aron 
in the year 1929, W. T. Salter postulated the existence of a control loop linking the 
pituitary and thyroid gland. This idea was inspired by the then recent description of 
the two gonadotropic feedback control loops. Only a few years later, Astwood and 
Hoskins could reveal both the existence and the pathophysiological relevance of 
this thyrotropic feedback control system. In 1968, Panda and Turner succeeded in a 
quantitative description of the interdependence of thyroxine and TSH levels, but 
the first mathematical models of the feedback loop had already been developed up 
to 12 years earlier [2-5]. 
 
Over the years, cybernetic models of thyroid homeostasis were increasingly 
improved, a success that was enabled by improved mathematical modelling 
methodology as well as growing empirical data. As a consequence of this continued 
evolution, some of the newest models are also suitable for medical decision-making 
[1, 6-9]. 
 
However, due to nonlinear interactions, these cybernetic models cannot 
simultaneously describe static and dynamic behaviour. This gap may be filled with 
computer simulations that additionally facilitate an intuitive insight into the 
dynamics of thyrotropic feedback. 
 
SimThyr is a simulation program for the pituitary thyroid feedback control that is 
based on a parametrically isomorphic model of the overall system [1, 10-13]. 
 
Applications of SimThyr cover research, including development of hypotheses, and 
education of students in biology and medicine, nurses and patients. 
 
Software and additional documentation of SimThyr are available from 
http://simthyr.sf.net. 
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Introduction 

SimThyr is a continuous simulator for pituitary-thyroid homeostasis. Pre-compiled 
Software is available for Mac OS X, Mac OS Classic and Windows. SimThyr was 
developed with Lazarus / Free Pascal (Mac OS X and Windows) or THINK Pascal 
(Mac OS Classic), respectively. Source code is provided for all supported platforms 
and may also be used in order to compile SimThyr for additional platforms. 
 
 

System Requirements 

 
Mac OS X 
SimThyr 3.3 for Mac supports Mac OS X 10.4 or newer on systems with either 
Intel or PPC processors.  
 
Windows 
SimThyr 3.3 for Windows has been developed for Windows XP and was 
successfully tested also on Windows 2000 and Windows 7.  
 
Mac OS Classic 
Mac OS Classic is supported by the legacy version SimThyr 2.0 only.  
 
Linux 
In order to use SimThyr on Linux please download the source code and compile it 
for your processor and operating system with Lazarus / Free Pascal. 
 
 

Installation 

 
For installing the program on Mac computers, simply drag the application file from 
the zip or BinHex package to the desired location on your file system. SimThyr for 
Mac doesn't come with and doesn't require an installer. 
 
The recommended way to install SimThyr on Windows-based computers is to use 
the provided installer. For special requirements, e.g. for installation on computers 
without administrative rights, a portable application is available, too. In order to 
install the portable version simply drag the application file from the archive to the 
desired location on your file system. You may also start SimThyr portable directly 
from a USB stick, a CD and even a web server (depending from the settings of 
your browser). This may have advantages e.g. for CBT labs and other computer 
resource centers. 
 
On Linux, please download the source code and compile it for your processor and 
operating system with Lazarus / Free Pascal. 



SimThyr 3.3   Handbook and Reference 

6 

 
 
Uninstalling SimThyr 

 
Before uninstalling SimThyr make sure that the application is not running. Then 
follow the directions of your operating system to delete the application file (on 
most platforms this is perfomed by dragging the file representation to the trash can 
icon). 
 
As required you may also want to delete scenarios and preferences files. 
 
 

Source Code 

 
Source code is available from http://sourceforge.net/projects/simthyr. For 
compiling SimThyr from source please follow the directions given there.
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SimThyr Guided Tour 

 

Starting SimThyr 

Start SimThyr by double-clicking its icon. After a short while a dialog box asking 
for simulation options is presented: 
 

 
 
 
First simulation 

For a first simulation simply hit the Start button on the dialog box or press the 
Enter key on your keyboard. This will start a simulation of one day under standard 
conditions. 
 

  
 
The Log window shows simulated values of time and hormone levels. In the plot 
window results are presented graphically. The small window titled “Prediction” 
displays predicted results from analytically solving the equations describing the 
feedback loop in a parametrically isomorphic model. 
 
Small deviations from the depicted results above may ensue from simulated 
random effects. 
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Experiment 1 

 
The first experiment simulates the development of subclinical (latent) 
hypothyroidism. 
 
In order to do this, first click the stop and reset button in the toolbar: 
 

 
 
 
 
This will delete all simulated values and set the time to zero. Then, start a new 
simulation over 14 days. Press the start button: 
 

 
 
 
 

and enter 14 days in the simulation settings dialog: 
 

 
 

After clicking “Start” you will obtain the result of 14 days in normal conditions that 
may be similar but not necessarily identical as depicted below. 
 

 

Stop and reset button 

Start button 
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Now, let’s develop subclinical hypothyroidism. In order to achieve this, click the 
start button again without hitting the stop button first. This will cause the 
subsequent simulation results to be appended to the previous results. 
 
In the simulation settings dialog don’t click the start button but on the button titled 
Structure parameters… in the middle of the lower part. This will open a new 
dialog enabling you to modify structure parameters of the overall feedback system. 
Here, change the thyroid’s secretory capacity (GT) to 1.2 pmol/sec, i.e. you should 
enter 1.2E-12 into the field depicted GT. 
 

 
 

After clicking the OK button the new value for GT is stored. Then change the 
simulated time to 21 days to allow for enough settling time. After clicking Start 
you should receive results that are similar to the following: 
 

 
 

Obviously, FT4 falls into the low-normal range while TSH oscillates between 
normal and elevated levels. 
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In the structure parameters window you may change virtually all constant structure 
parameters of thyroid homeostasis including volumes of distribution, time 
constants and dissociation constants. Useful starting points for experimentation 
may be sum activity of peripheral deiodinases (GD) and the secretory capacity of 
thyrotropic anterior pituitary cells (GH). 
 
 
Experiment 2 

 
This simulates the effects of modifications in plasma proteins, e.g. in pregnancy or 
on anticonceptive medication. 
 
First, reconstruct standard conditions by clicking Standard in the structure 
parameters window and confirm with OK. Then, click the stop and reset button in 
the toolbar in order to delete all entries and start with time point 0. 
 
After clicking the start button you will get the already well-known simulation 
settings dialog. Here click on 50% TBG rise in the lower part of the window. 
 

 
 

To allow for the necessary settling times enter 30 days for total simulation and 7 
days as beginning of the effect. 
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The results should be similar as depicted above, showing a decrease of FT4 levels 
in the beginning of the effect, than a short increase in TSH levels and a consecutive 
slight TSH decrease as FT4 rises in the achievement of a new equilibrium point. 
 
You may change the combo boxes in the plot window in order to study the effects 
on other hormones of the feedback loop. 
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User Interface 

Toolbar 

Most functions of SimThyr are accessible from the toolbar. If you move the mouse 
cursor to a button and leave it there for a second without clicking, a small tool tip is 
displayed explaining its function. 
 

 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

Simulation buttons (see below) 

Standard edit buttons for undo, cut, copy and paste. 

File buttons: Create, save and open files, e.g. scenarios, here. 

Stop and reset button: Stops a simulation and resets timers,  
if simulation was already stopped. 

Pause button: Suspends simulation. 

Run button: Starts a new simulation and resumes a suspended simulation. 

Parameters button: Modify structure parameters of 
feedback control here. 

IPS button: Displays information processing structure. 

Settings button: Set global application preferences here. 

Settings and scenario buttons (see below) 

TP button: Click here for getting a tornado plot, a 
special form of multi-way sensitivity analysis. 

TWSA button: Performs two-way sensitivity analysis. 

1WSA button: Perform one-way sensitivity analysis here. 

Sensitivity analysis buttons (see below) 
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Main Menu 

Additional options are available from the main menu. It will look slightly different 
on Mac OS, Mac OS X, Windows and Linux. However, the principal functions are 
identical. 
 

 
 
SimThyr menu: Application-wide options, e.g. Preferences and Services (Mac OS X 
only) 
 
File menu: File- and scenario-wide options, e.g. for opening and saving files. 
 
Edit menu: Standard editing options like cut, copy and paste. 
 
Simulation menu: Options for starting, stopping and suspending simulations and 
for changing structure parameters. 
 
Window menu: Select background or hidden windows here. 
 
Help menu: Help and additional information.
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Scenarios 

Simulation scenarios, e.g. containing a set of structure parameters in certain thyroid 
disorders, may be stored as XML files and reused. This may be a useful option for 
talks or educational purposes (SimThyr 3.0 or newer only). 
 
Examples for useful scenarios are sets of structure parameters in certain thyroid 
disorders and influencing factors in some conditions like pregnancy or critical 
illness. 
 
In order to save a scenario, select the entry Save from the File menu and make 
sure that the format Scenario (XML) is selected in the save dialog. 
 
You can open and reuse an existing scenario by selecting Open Scenario… from 
the File menu. 
 
 
 

Sensitivity Analysis 

In its essence, cybernetic modelling maps a system’s structure onto its behaviour. 
This applies to both mathematical descriptions and simulation. A more methodical 
implementation of this approach is sensitivity analysis, a very powerful method in 
systems science. 
 
Sensitivity analysis systematically varies a structure parameter and investigates 
resulting behavioural variables. This helps to study the influence of certain marginal 
conditions on relevant output variables and to define factors that are critical for 
definite wanted (or unwanted) results. Additionally, this method allows assessing 
how the uncertainty of behavioural variables can be apportioned to different 
sources of uncertainty in model input. 
 
Sensitivity analysis is available with SimThyr 3.1 (Hyperborea) and above, two-way 
sensitivity analysis was introduced with SimThyr 3.3 (Gaia). 
 
One-way sensitivity analysis, two-way sensitivity analysis and tornado plots may be 
accessed from the Simulation menu. Usage should be self-explanatory. In both 
windows select independent structure parameters and dependent behavioural 
parameters (i.e. hormone levels). The resulting plots may be modified with respect 
to colour and (for one-way sensitivity analysis) for lower and upper boundaries of 
structure parameters. 



SimThyr 3.3   Handbook and Reference 

 

  15 

 

Preferences 

Global application preferences allow for setting measurement units and number 
formats for all your simularions. 
 

 
The flexible modular menu structure enables you to compose virtually every 
imaginable measurement unit. Your entry is parsed and automatically converted to 
correct conversion factors. 
 
Number formats are also very flexible. You may specify Free Pascal - style format-
strings to set the number of digits and type of notation: 
 
0: Digit place holder. The digit of the corresponding place in the 

number will replace 0, otherwise a missing digit is filled with 0. 

#: Digit place holder. A digit in the value will replace the 

corresponding #, a missing digit is replaced by a space. 

.: Location of decimal separator 

,: Location of thousands separator 

E+, e+, E- and e-: Scientific notation. # signs after E+ denote the 

number of places. 

; Separates positive, negative and zero numbers, respectively. 

 
Examples: 
 
###,###.00##: 1,234.50 
######.0: 1234.5 
#.###E+: 1.235E+5 
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Date formats may be specified with format strings, too: 
 
D: day 

dd: day with leading zero 

h: hour 

n: minute 

s: second 
 
Examples: 
 
"d"D hh:nn:ss: d1 03:31:40 
hh:nn “h”: 03:31 h 
 
 

Supported File Formats 

SimThyr supports export of simulation results in various formats including tab-
delimited, CSV and DIF files. Both tab delimited and CSV are simple table 
formats, where columns (i.e. different simulated parameters) are separated by 
tabulator or comma signs and time points are delimited by carriage return or 
linefeed symbols (depending from platform conventions). DIF (data interchange 
format) is a standard for a neutral representation of contents that facilitates the 
transfer of data among various applications. 
 
All of the mentioned formats are supported by a wide range of database, statistics 
and spreadsheet applications. 
 
Plots may be saved in multiple varieties of image formats including bitmap (BMP), 
pixmap (XPM), portable pixmap (PPM), joint picture expert group (JPEG) format, 
tagged image file format (TIFF), portable network graphic (PNG) and, still 
experimentally in SimThyr 3.3, scalable vector graphic (SVG). 
 
Scenarios and preferences are saves as XML files. 
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